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Accounts Help 

Accounts is a personal finance and small business accounting solution for Mac OS X. 

You can keep track of your personal or business finances quickly and easily with Accounts. 

Overview 

Accounts lets you record your personal finance or business transactions, including receipts, payments and banking information on a daily
basis or whenever you have time. Accounts automatically prepares your finanical reports, saving you time, and giving you control over your
money by letting you know exactly how your finances are performing at any time. 

How to Buy Accounts 

You can buy an Accounts license from the Nano Store or by selecting "Buy Accounts..." from the Accounts Help menu. 

We accept all major credit cards and use Kagi to process your secure online purchase. You will receive a personalised license code within
24 hours. To enter your code select "Preferences" from the Accounts Menu and click on the "License" icon in the Preference Window
toolbar. Enter your license name and code in the appropriate fields exactly as they appear in your license e-mail. Please note license
details are case sensitive. 

Using Help 

You can access Accounts Help from the Help Menu within Accounts.  Further tips are available by placing your cursor over buttons, fields
and other interface objects within Accounts. 

Support 

If you have any questions, suggestions or need something explained that is not covered by the help documentation please contact us.  You
can contact us by selecting “Send Feedback...” from the Accounts Help menu or by sending an email to support@nano.com.au. 

Statutory Requirements 

Accounting for taxes and other employee details is complex, so be sure to understand the governmental reporting requirements for your
tax jurisdiction.  Accounts allows you to record information about personal and home finances, and small businesses such as sole traders
and partnerships.  Businesses may be required to keep additional records to meet statutory reporting obligations. 

Data Safety and Integrity 

Accounts is continually under development and is provided without any guarantees or warranties as to its fitness for purpose or
functionality apart from those required under the relevant laws in your jurisdiction.  This means that the program may contain bugs which
have not been identified.  If any issues affecting data integrity are found they will be posted at http://www.nano.com.au.  Please ensure
that you backup your Accounts data regularly (we recommend at least weekly).  You may decide to backup your data more or less often
depending on how much information you are prepared to risk. 

Always backup your data before starting a new year. 

Quick Start 

Here's all you need to know to start using Accounts in about 30 seconds ... 

Create a New File 

From the File Menu select "New...". Or, from the startup window choose "Create New File...". 
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Add a Transaction  

Click the transaction icon (the blue pencil) in the toolbar. The "Transaction Entry" window will open. 

Here you can enter "Receipts & Sales", "Payments & Purchases" and "General Journal" transactions. 

Customizing Accounts 

You can create new asset, liability, equity, revenue and expense accounts as you need them. There's no need to create any new accounts
before you enter your first transaction. Each Accounts file contains a default set of accounts that you can customize at any time. 

More Help ... 

The following section "How to Use Accounts" explains the above steps and others in further detail. 

How to Use Accounts 

How to get the most from Accounts. 

Create a New File 

To create a new Accounts file, from the File Menu choose "New...". Or, from the startup window choose "Create New File..." (picture below).

 

Then enter the following information: 

Choose a default account style. You can select from personal, business or custom styles.
Enter your name or the name of your business.
Enter the last day of your initial financial year. For example, if your financial year ends on 31 December 200x, you would enter 31
December 200x.

 

What Information Should I Enter? 

At a minimum you might want to enter all transactions appearing on your bank or credit card statements. To keep more complete records,
you would enter every transaction that affects your personal/business finances. 

To keep track of your finances, you will record the income you receive and the expenses you incur. You might also buy assets and make
credit card or loan repayments. 

Personal/business income (or revenue) includes: 

Sales Revenue
Interest Revenue
Dividend Revenue
Salary Revenue
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Wages Revenue

Personal/business expenses include: 

Rent Expense
Utility Expenses
Motor Vehicle Expenses
Postage Expenses
Wage or Salary Expenses (if you are operating a business)
Office Stationery Expenses

Assets include: 

Computer
Office Equipment
Motor Vehicle
Furniture
Stock

Liabilities include: 

Credit card (MasterCard, Visa, AMEX, etc)
Loan
Accounts Payable

For a full explanation of Assets, Liabilities, Equity, Revenue and Expenses see the Accounts Help section titled "Accounts". 

When Should I Enter Information? 

Regularly keeping track of your financial information will give you more control over your financial position. If you are keeping records for a
business, a few minutes spent each week entering transactions will save you from the huge task of entering all of your data at the end of
the financial year. Keeping track of your own financial information can also reduce your end of year accounting and tax costs. 

If all your transactions take place through one bank account the simplest way to record your transactions is to enter your information from
your bank statements once a month. If you have any transactions that do not go through your bank account, such as petty cash
transactions, save the receipts, and also enter those when you enter the information from your bank statements. 

To really stay on top of your finances, you could enter transactions as they occur. For example, if you make payments by check, you can
enter the payment information into Accounts, and if you use pre-printed checks, Accounts can print the check for you. Similarly, if you
have a business, Accounts can produce invoices. 

Some transactions, such as bank charges or interest revenue, might only be entered when you receive your bank statement or when you
view your bank information online. 

Your accountant may also provide you with information that might only be entered at the end of the financial year. For example, this may
include amounts to expense for the depreciation of assets. 

How to Enter Information 

You enter information into Accounts using the "Transaction Entry" window. To open the Transaction Entry window click on the
"Transaction" icon in the Accounts toolbar. 
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The Transaction Entry window has three tabs for the following journals: 

Receipts & Sales Jounral
Payments & Purchases Journal
General Journal

You will enter most transactions into the 'Receipts & Sales' and 'Payments & Purchases' journals. 

 

You use the Receipts & Sales Journal when you receive income. For example, if you are keeping track of your personal finances, you would
record your salary or wage income here. If you are keeping track of your business finances you would record your sales transactions here.
Similarly, if you received income from selling an asset, you would record the receipt of funds here. Choose the account that the funds are
deposited into from the popup button labelled "Debit". The balance of this account will increase by the transaction amount. 

You use the Payments & Purchases Journal when you pay expenses, for example, such as a utility bill. Payments also occur when you pay
for an expense with a credit card, buy an asset, and when you make a payment to reduce a liability such as a credit card. Choose the
account used to pay for the expense from the popup button labelled "Credit". The balance of this account will be reduce by the transaction
amount. 

The General Journal is the third type of transaction entry journal. Every transaction can be entered as a general journal entry. However, it is
usually simpler to use the Receipts & Sales and Payments & Purchases journals for most transactions that involve the payment or receipt of
cash or credit. The General Journal is usually used for infrequent or adjusting transactions. For example, you may need to create a
provision for bad debts, or enter the yearly depreciation for an asset. At the end of the fiancnail year your accountant may provide you
with the journal entries for these types of transactions. 

You will find more information about how to enter your financial information in the Help section titled "Transactions". 

Opening Balances 

When starting a new file or at any time during the initial financial year you can enter an opening balance for any account in the Account
Details window. Accounts uses the "Unallocated Opening Balances" account to balance your opening balances if necessary. 
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You can also set the opening balance of an account by entering a General Journal transaction on the first day of your first financial year. 

End of Year 

When you have finalised all transactions for a past financial year, you will be ready to start the next financial year. To do this, choose "File"
then "Start a New Year...". There's no rush to start a new year as transactions relating to future financial years can be entered at any time. 

 

When you choose "Start a New Year..." Accounts will:

Transfer the balances of all Revenue and Expense accounts to the Retained Earnings account.
The balances of all Asset, Liabilty and Equity accounts will be unaffected.

The Revenue and Expense accounts are closed in order to determine the profit or loss for the year, and to transfer the profit or loss for
the closing year to the retained earnings account. Again, there is no rush to "Start a New Year" since you can continue entering transactions
for subsequent financial years without starting a new year. However, once you do start a new year, you will no longer be able to enter
transactions with dates during the closed year. 

 

Accounts 

You can keep track of your financial information by classifying your income and expenditure into various accounts. 

You might need only a dozen accounts to keep track of your personal or small business finances. Larger businesses would use more
accounts. 

Account Types 

In Accounts you use five basic account types (or natures) to track your financial information. The five account types are: 
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Asset
Liability
Equity
Revenue
Expense

Assets  

The "Cash at Bank" account is an asset. Other assets include computers and motor vehicles. 

Liabilities 

Credit cards such as AMEX, MasterCard and Visa, and loans payable are examples of liability accounts. 

Revenue  

Revenue accounts include sales revenue, wages revenue, salary revenue, interest revenue and dividend revenue. 

Equity 

Your net financial position is represented by the net total of the equity account balances. The earnings accounts represent the
surplus/deficit of income over expenses. You might also have an amount in the capital account. This is your contribution to your financial
position. 

Expenses 

Bank charges, electricty, gas and stationary are examples of expense accounts. 

If you are uncertain whether a new account is necessary you should create it. Your accountant will prefer more, rather than less, detailed
records. Generally, transactions using the new account can be changed to use another account later provided that you have not closed the
year containing the transaction you want to change. 

Adding New Accounts 

To create a new account click the account icon in any of the toolbars. Or, you can click the "Add Account" button at the bottom of the
"Accounts" tab. The account window will appear. 

 

You will enter the following information for each new account:

Use account for receipts and payments - check the box if the account is a fund account (explanation below)
Nature - choose from Asset, Libility, Equity, Revenue or Expense
Number - enter an account number from 0001 to 9999
Name - enter an account name
Default Details - this information will appear in transactions involving this account
Opening balance - enter an amount if the acocunt has an openeing balance, for example, for a bank account

Fund Accounts 

Fund Accounts are the accounts that appear in the popup buttons at the top of the Receipts and Payments journals. If you have a check
account, make it a fund account. Then you can use Accounts to print checks on pre-printed check stationery. Make any account that you
use to make payments from or deposit funds into a "Fund" account. This will include credit card accounts. You can determine which
accounts are fund accounts by selecting the Accounts tab. The "Type" column displays whether an account is a fund account, a total
account, or a normal account. 
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Editing Accounts 

To edit an existing account highlight the account in the "Accounts" tab and then click the "Edit" button at the bottom of the window.
Alternatively, you can edit an account by double-clicking on it. You will not be able to change the nature of an account if it has been used
in any transactions. 

Deleting Accounts 

To delete an account highlight the account you want to delete in the "Accounts" tab and then click the "Delete" button at the bottom of the
window. You will only be able to delete accounts that have not been used in any transactions. 

Transactions 

This section explains how to use the Receipts & Sales, Payments & Purchases and General Journals and also how to enter cash and credit
transactions. 
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Add a Transaction  

You will use the "Transaction Entry" window to enter transactions. To enter a new transaction click the "Transaction" icon in the toolbar. Or,
click the "Add Transaction" button at bottom of the transaction tab. The transaction entry window will appear. 

 

The following sections describe how to use the Receipts & Sales, Payments & Purchases and General Journals and also how to enter credit
sales and credit purchases. 

Edit a Transaction  

You can edit an existing transaction by highlighting the transaction in the "Transactions" tab and clicking the "Edit" button. Or, you can
edit a transaction by double-clicking it. You can only edit a transaction if it is within a financial year that has not been closed. 

Delete a Transaction  

To delete a transaction highlight the transaction you want to delete in the "Transactions" tab and click the "Delete" button at the bottom of
the window. You will only be able to delete a transaction if it is within a financial year that has not been closed. 

Duplicate a Transaction  

Command-click (or right-click) any transaction to duplicate the underlying transaction. A new transaction based on the duplicated
transaction will appear in the transaction entry window. 

Receipts and Sales Journal 

Use the Receipts & Sales journal when you receive cash or make a sale. This includes recording all types of incom, sales revenue,
commission revenue and also when you receive cash from the sale of assets. 
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Payments and Purchases Journal 

Payments are usually the most common type of transaction.  Use the Payments & Receipts Journal when paying for items with cash or
credit card and also when purchasing items on credit. 

 

General Journal 

Use the General Journal to enter transactions that do not involve a fund account, such as a depreciation transaction. 

 

Credit Sales 

When you make a credit sale you will not receive cash. Instead you will need to record that someone (called a debtor) owes money to you.
If necessary, create an account for the debtor. The account will be an asset account. Below we create a debtor account called "Debtor -
CMS Projects". 

Select the checkbox titled "Use account for receipts and payments" at the top of the account details window. This will make the account a
fund account. 

Check this box for debtors and creditors (and any accounts) that you want to appear in the popup button at the top of the "Receipts and
Sales" and "Payments and Purchases" journals. 



09/18/2005 01:03 PMAccounts Help

Page 10 of 25file:///Users/tony/Developer/Accounts/Accounts%20Help/Accounts%20Help%201.9%20PDF%20Layout/content/printableVersionMain.htm

 

The following transaction records sales revenue owing from CMS Projects. 

 

Receipts from Debtors 

When a debtor eventually pays for an item originally purchased on credit, you will use the Receipts & Sales Journal to record the receipt of
cash. At the top of the Receipts & Sales journal select the account that the money received will be deposited into. This will often be the
"Cash at Bank" account. In the lower part of the journal enter the debtor's account and the amount received. 

The following example records a payment received from a debtor called CMS Projects. CMS Projects is paying the widgets sold in the credit
sales transaction above. 
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Invoices and Quotes 

To print an invoice click the "Invoice" icon in the Transaction Entry window toolbar while the transaction is visible in the Transaction Entry
window. 

If you cannot see the Invoice icon in your Transaction Entry window toolbar, ensure the Transaction Entry window is the frontmost window
and select "Customize Toolbar" from the "Window" menu. You can also customise any toolbar by control-clicking it. 

 

Invoice Information 

The information shown on invoices is sourced from three places: 

. 1 The sales transaction itself provides the information specific to the invoice. This includes the "Invoice To" name, address, memo,
date, invoice number, total amount and the individual invoice items. The text appearing in the "Details" column of the sales
transaction will appear in the invoice's "Details" column.

To set or change the default invoice details for a particluar account, select the account in the "Accounts" tab, click the "Edit"
button, and enter the default invoice information in the "Default Details" field. 

. 2 The invoice title (eg., "Tax Invoice"), due days, and default terms can be customised in Account's Preferences window by selecting
the "Sales" tab.

To produce quotes, change the "Sales Invoice Title" popup to "Quote". 

. 3 Your business name, address and contact information are sourced from the file's Address Book Card. You can set the Address Book
Card for the file in the "Contacts" tab.
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Credit Purchases 

When purchasing an item on credit you'll need to enter a transaction to record the amount payable to the person providing the goods or
services (ie, the creditor). To create an account for the creditor, select the "Accounts" tab and click "Add Account". 

 

In the "Account Details" window above, the account is called "Creditor - OfficeWorks". Make the account a liability account. Also, select the
"Use account for receipts and payments" checkbox to make the account a fund account. Fund accounts appear in "Debit" and "Credit"
popup buttons at the top of the "Receipts & Sales" and "Payments & Purchases" journals. 

The following screenshot shows a credit purchase using the creditor account created above. 
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Payments to Creditors  

When paying a creditor for items purchased on credit, select the Payments & Purchases journal. From the "Credit" popup button select the
account the money is being paid from. For example, the "Cash at Bank" account. In the details section (ie, the lower half of the
transaction), enter the creditor's account and the amount being paid. 

 

In the above example, we are paying OfficeWorks for supplies previously purchased on credit. 

Purchase Orders 

The process for creating purchase orders is similar to the creation of invoices. 

The information shown on a purchase order is sourced from three places: 

. 1 The "Payment & Purchase" transaction itself provides the information specific to the purchase order. This includes the supplier
name, address, memo, date, purchase order number, total amount and the individual purchase items. The text appearing in the
"Details" column of the purchase transaction will appear in the purchase order's "Details" column.

. 2 The purchase order title (eg, "Purchase Order"), due days, and default terms can be customised in Account's Preferences window
by selecting the "Purchase" tab.

. 3 Your business name, address and contact information are sourced from the file's Address Book Card. You can set the Address Book
Card for the file in the "Contacts" tab.

Example Transactions 

The Accounts Disk Image contains two sample files titled "BusinessDemo.acc" and "PersonalDemo.acc". You can explore the transactions in
these files to become familiar with transactions. 
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Ledger 

The Ledger can display all transactions containing a specified account, a group of accounts, or all accounts. 

For example, selecting the "Cash at Bank" account from the "Display" popup button displays each transaction involving the "Cash at Bank"
account. Selecting the the "Asset" group from the "Display" popup button displays all transactions for all asset accounts. 

 

You can also filter the transactions by date by entering dates into the "From" and "to" fields. 

Ledger headings:

The "Jnl" column indicates whether a transaction is a "Receipts & Sales", "Payments & Purchases", or "General Journal" entry.
The "Description" column shows each transaction's contact and memo information.

Ledger amounts:

The "Opening Balance --" amount is the account balance on the date specified in the "From" field.
The "Closing Balance --" amount is the account balance on the date specified in the "to" field.
The "Net Movement" is the difference between the "Opening Balance" and "Closing Balance"
The "Totals" are the total debits and total credits of the displayed transactions

View a Transaction  

Double-click any ledger row to view or edit the underlying transaction. 

Duplicate a Transaction  

Command-click (or right-click) any ledger row to duplicate the underlying transaction. A new transaction based on the duplicated
transaction will appear in the transaction entry window. 
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Reconciliation 

The reconcilialtion tab lets you reconcile the transactions on your bank or credit card statement with the transactions in Accounts. 

How to Reconcile 

To reconcile a bank or credit card account:

Select the account you want to reconcile from the "Account" popup button.
Enter your statement's closing date into the "Statement Closing Date" field.
Enter your statement's closing balance into the "Statement Closing Balance" field.
For each transaction on your statement, select the checkbox next to that transaction in Accounts.
You can select and deselect all transactions by clicking the "Select All" and "Deselect All" buttons in the bottom left corner of the
Reconcile tab.

If a transactions appears on you bank statement, but not in Accounts, enter it into Accounts. 

The first time an account is reconciled, the "Statement Opening Balance" amount is taken from the Account's opening balance field in the
"Account Details" window. 

 

Reconciliation Balances 

Each time you select or deselect a transaction, the "Calculated Balance", "Out of Balance" and "Selected Transactions" amounts will change. 

The "Calculated Balance" is determined by adding the value of each selected transaction to the "Statement Opening Balance". For example,
if your "Statement Opening Balance" is 200 and you select a receipt of 50, the "Calculated Balance" will change to 250. If you then select a
payment of 10, the calculated balance will change to 240. 

The "Out of Balance" amount is the difference between the "Current Statement Balance" and the "Calculated Balance". The "Out of Balance"
amount must be nil before the reconciliation can be finalised. 

When all transactions appearing on your statement are selected in Accounts the "Statement Closing Balance" and the "Calculated Balance"
should match and the "Out of Balance" amount should be nil. 

Ready to Reconcile 

To finalise the reconciliation, press the "Reconcile" button. Accounts will check whether the reconciliation balances before processing the
reconciled transactions. 

The reconciled transactions will be removed from the next reconciliation. The closing date and closing balance will become the opening
date and opening balance for your next reconciliation. 
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Contacts 

Accounts uses the Mac OS X Address Book to manage your contact information. 

You can associate a contact with each transaction. 

To enter contact information for a transaction, in the "Transaction Entry" window, type the contact name in the "Contact" field, or select a
contact from the "Contact" popup button (see picture below). 

 

The following sections explain how to add a contact to the "Contact" popup button in the "Transaction Entry" window (pictured above). 

Contacts Tab 

In the "Contacts" tab you can:

View all of your Address Book cards and groups.
Choose the Address Book Card associated with your file from the "My Address Book Card" popup button located in the top left
corner of the "Contacts" tab.
View the Address Book Group associated with your file in the "My Address Book Group" field located in the bottom left corner of
the "Contacts" tab.
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My Address Book Card 

Accounts uses the contact information in the "My Address Book Card" when printing checks, reports, invoices and purchase orders. 

To choose the Address Book Card associated with your data file, select an Address Book Card from the "My Address Book Card" popup
button. The "My Address Book Card" popup button contains all Address Book Cards in the Address Book Group used by your file. You can
change the Address Book card associated with your data file at any time. 

My Address Book Group 

The Address Book Group associated with your file is shown in the "My Address Book Group" field located at the bottom of the "Contacts"
tab. This is the Address Book Group that Accounts uses to store your file's contact information. The Address Book Group generally has the
same name as the data file that you are working with. You can add any Address Book Card to your Address Book Group by opening the
Mac OS X Address Book and dragging an Address Book Card into your Address Book Group. 

Add a Contact 

You can add a new contact by clicking the "Contact" icon in the toolbar of most windows, or by clicking the "Add Contact" button in the
bottom right corner of the "Contacts" tab. A new Address Book Card will appear ready for editing. 

 

When you finish editing the new Address Book Card it will appear your file's Address Book Group and also in your Address Book's "All"
Group. You can access the new Address Book Card in the contact list in the "Transaction Entry" window. 

Edit a Contact 

You can edit a contact by double-clicking the contact in the "Contacts" tab, or by highlight the contact in the "Contacts" tab and clicking
the "Edit" button in the bottom right corner of the "Contacts" tab. 

Delete a Contact 

To delete a contact, in the "Contacts" tab highlight the contact and click the "Delete" in the bottom right corner of the "Contacts" tab. 



09/18/2005 01:03 PMAccounts Help

Page 18 of 25file:///Users/tony/Developer/Accounts/Accounts%20Help/Accounts%20Help%201.9%20PDF%20Layout/content/printableVersionMain.htm

Memos 

The "Memos" tab is a convenient place to store information within Accounts 

 

Add a Memo  

You can create create to do lists and reminders by entering information into the "Memo" window. 

To create a new memo click the "Memo" icon in the toolbar. Or, you can click the "Add Memo" button in the bottom right corner of the
"Memos" tab. The "Memo Details" window will appear. 

 

Edit a Memo  

You can edit a memo by highlighting it in "Memos" tab and clicking the "Edit" button. Or, you can double-click any memo to edit it. 

Delete a Memo  

You can delete a memo by highlighting the memo in the "Memos" tab and clicking the "Delete" button. 
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Reports 

The "Reports" tab contains three reports that summarise your finances:

Profit and Loss
Balance Sheet
Trial Balance

In addition to these reports, you can also print the information displayed in the Accounts, Transactions, Ledger, Reconciliation and
Contacts tabs. 

Profit and Loss 

The "Profit and Loss" report presents a summary of your revenues and expenses for any given period. 

You can change the report period by clicking the "Report Options..." button in the top right corner of the "Reports" tab. 

 

Balance Sheet  

The "Balance Sheet" report presents a summary of your asset, liability and equity account balances at any given date. 

You can change the report period by clicking the "Report Options..." button in the top right corner of the "Reports" tab. 
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Trial Balance 

The "Trial Balance" report presents a summary of all accounts balances (ie, assets, liabilities, equities, revenues and expenses) at any given
date. 

You can change the report period by clicking the "Report Options..." button in the top right corner of the "Reports" tab. 

 

Export 

You can export transaction, account, contact and memo information. 

To export information select "Export..." from the "File" menu. The export options sheet will appear. 
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Transactions 

You can export all transactions or transactions during a given period.

To export transactions during a given period, enter dates into the "From" and "To" fields.
To export all transactions select the "All" radio button.
To export no transactions select the "None" radio button.

Accounts, Contacts and Memos 

You can also export all Accounts, Contacts and Memos.

Select the checkbox next to the information that you want to export.
Contact information is exported in v-card format.

File Extensions 

Your information is exported in tab-delimited format.

In the "Export" file sheet you can choose between .txt and .xls file extensions.
Using the .xls extension may help spreadsheet applications open your exported data more easily.

 

Export Sample  

You can manuipulate exported data in a spreadsheet application. The following image shows the format of exported transactions. 

 



09/18/2005 01:03 PMAccounts Help

Page 22 of 25file:///Users/tony/Developer/Accounts/Accounts%20Help/Accounts%20Help%201.9%20PDF%20Layout/content/printableVersionMain.htm

Check Printing 

You can print checks on pre-printed check stationery. Accounts supports standard 3-up checks and voucher checks. 

The following sections discuss how to:

Enter check transactions
Select the checks you want to print, and
Customise check layouts.

Check Transactions 

To enter a check transaction, use the "Payments & Purchases" journal in the "Transaction Entry" window.

Select the check account from the "Credit" popup button.
Enter the check number into the "Ref" field.
Enter the remaining payment information as usual.

If your check account does not appear in the "Credit" popup button you will need to make the check account a " Fund Account". For
examples of how to enter payment transactions view the Transactions help section. 

How to Print a Check 

To print a check select "Print Checks..." form the "File" menu. The "Check Selection" window will appear. 

 

You select the checks that you want to print in the "Check Selection" window. 

The "Check Selection" window provides the following options:

Select the account containing the checks you want to print from the "Account" popup button.
Select the check layout for the checks being printed from the "Layout" popup button.
Select the number of checks on the first page of 3-up check stationery from the "Checks on first page" popup button.
The "Checks on first page" popup button is disabled for voucher layouts.
You can force all checks to print using the current date by selecting the "Use today's date when printing checks" checkbox.

The following filter options are available:

Filter the check transactions by date using the "From" and "to" fields.
Filter the check transactions by check number using the "Check" and "to" fields.
You can view all checks or only unprinted checks by selecting the "Show unprinted checks only" checkbox.

To select a check for printing, select the "Print" checkbox next to the check. The image below shows two checks selected for printing. 
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The "Check Selection" window also contains the following buttons:

The tick and cross buttons in the bottom left corner of the window select and deselect all visible transactions.
The "Customize Check Layout..." button opens the "Check Layout" window (discussed below).
The "Print Selected Checks..." button.

After selectint the checks you want to print click the "Print Selected Checks..." button. A print dialog sheet will appear. 

After a check is printed, if the "Show unprinted checks only" checkbox is selected the printed check will be removed from the "Check
Selection" cheque listing. If you need to reprint a check, deselect the "Show unprinted checks only" checkbox. You will then be able to see
all checks. 

Customise a Layout 

You will need to customise the check layout for each check account that you operate. 

To customise a check layout select the "Customize Check Layouts..." button in the "Check Selection" window. The "Check Layouts" window
will appear. 

 

You can create multiple check layouts. Click the "+" and "-" buttons in the bottom left corner of the window to add or remove a layout. You
can rename a check layout by double-clicking the layout name in the "Layout" column. 

You can choose from four layout styles in the "Style" popup button. The layout styles are:

Standard - 3 Up
Voucher - Top
Voucher - Middle
Voucher - Bottom

To specify the size of a check enter values into the "Width" and "Height" fields in the "Check" section. The check size is represented by a
blue rectangle outine. 

You can customise the location and size of each check field, and also whether a check field is printed. The printable check fields are:

Date
Payee
Amount in Words
Amount in Numbers
Payee's Address
Transaction Memo

To change the position of a field you can:

Drag the field.
Enter values into the "x", "y", "Width" and "Height" fields in the "Field" section.
Select the field by clicking it and use the arrow keys to move the field.

You can change each field's font and font size by selecting a field and clicking the "Font..." button. 

To preview a check layout click the "Preview Check Layout..." button. A print dialog sheet will appear. 
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Preferences 

Accounts' Preferences allow you to customise various settings to suit your needs. 

General 

In the "General" preferences you can: 

Choose whether the "Startup Window" appears each time Accounts is launched.
Choose whether the "Account Drawer" opens each time the "Transaction Entry" window is opened.
Set the side on which the "Account Drawer" slides out from when the transaction window is opened.
Choose the journal that appears each time the "Transaction Entry" window is opened.
Choose the default date for transactions.
Change the alternate row color for each of the journals.
Select the font that is used for printed reports.

 

File 

In the "File" preferences you can:

Choose a default file that opens each time Accounts is launched.
Choose to save your file each time a transaction is saved.
Choose to backup your file each time it is closed and select a location.
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Sales 

In the "Sales" preferences you can:

Set the "Sales Invoice Title" that appears on sales invoices..
Set the "Terms" message that appears on sales invoices.
Set the "Balance Due" days used for sales invoices.
Set the "Note" that appears on the bottom of all sales invoices.

 

Purchases 

In the "Purchases" preferences you can:

Set the "Purchase Order Title" that appears on purchase orders..
Set the "Terms" message that appears on purchase orders.
Set the "Balance Due" days used for purchase orders.
Set the "Note" that appears on the bottom of all purchase orders.

 

License 

In the "License" preference you can enter your licence name and code exactly as they appear in your license email. Please note that licence
details are case sensitive. You can avoid typing errors when entering your license by copying your license details from your license email
and pasting them into the "Name" and "Code" fields. 

 


